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Preface

For details, see the following topics:

• Progress Corticon documentation - Where and What

• Overview of Progress Corticon

Progress Corticon documentation - Where and What
Corticon provides its documentation in various online and installed components.

Access to Corticon tutorials and documentation

Corticon Online Tutorials

Online only. Uses samples packaged in the
Corticon Studio.

Tutorial: Basic Rule Modeling in Corticon Studio

Online only.Tutorial: Advanced Rule Modeling in Corticon
Studio

Corticon Online Documentation

Updated online help for the current release.Progress Corticon User Assistance

Included in User Assistance. Not available in
Studio help.

Corticon Server: Web Console Guide

Individual PDFs (including Web Console guide)
and JavaDocs

Progress Corticon Documentation site
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Corticon Documentation on the Progress download site

Package of all guides in PDF format.Documentation

PDF format.What's New Guide

PDF format.Installation Guide

Include Eclipse help for all guides except Web
Console.

Corticon Studio Installers

Components of the Corticon tutorials and documentation set

The components of the Progress Corticon documentation set are the following tutorials and guides:

Corticon Online Tutorials

An introduction to the Corticon Business Rules
Modeling Studio. Learn how to capture rules from
business specifications, model the rules, analyze
them for logical errors, and test the execution of
your rules -- all without any programming.

Tutorial: Basic Rule Modeling in Corticon Studio

An introduction to complex and powerful functions
in Corticon Business Rules Modeling Studio.
Learn the concepts underlying some of Studio's
more complex and powerful functions such as
ruleflows, scope and defining aliases in rules,
understanding collections, using
String/DateTime/Collection operators, modeling
formulas and equations in rules, and using filters.

Tutorial: Advanced Rule Modeling in Corticon
Studio

Release and Installation Information

Describes the enhancements and changes to the
product since its last point release.

What's New in Corticon

Step-by-step procedures for installing all Corticon
products in this release.

Corticon Installation Guide

Corticon Studio Documentation: Defining and Modeling Business Rules

Presents the concepts and purposes the Corticon
Vocabulary, then shows how to work with it in
Rulesheets by using scope, filters, conditions,
collections, and calculations. Discusses chaining,
looping, dependencies, filters and preconditions
in rules. Presents the Enterprise Data Connector
from a rules viewpoint, and then shows how
database queries work. Provides information on
versioning, natural language, reporting, and
localizing. Provides troubleshooting of Rulesheets
and Ruleflows. Includes Test Yourself exercises
and answers.

Corticon Studio: Rule Modeling Guide
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Reference guide to the Corticon Studio user
interface and its mechanics, including descriptions
of all menu options, buttons, and actions.

Corticon Studio: Quick Reference Guide

Reference information for all operators available
in the Corticon Studio Vocabulary. Rulesheet and
Ruletest examples are provided for many of the
operators.

Corticon Studio: Rule Language Guide

Detailed technical information about the Corticon
extension framework for extended operators and
service call-outs. Describes several types of
operator extensions, and how to create a custom
extension plug-in.

Corticon Studio: Extensions Guide

Corticon Enterprise Data Connector (EDC)

Introduces Corticon's direct database access with
a detailed walkthrough from development in
Studio to deployment on Server. Uses Microsoft
SQL Server to demonstrate database read-only
and read-update functions.

Corticon Tutorial: Using Enterprise Data
Connector (EDC)

Corticon Server Documentation: Deploying Rules as Decision Services

An in-depth, technical description of Corticon
Server deployment methods, including
preparation and deployment of Decision Services
and Service Contracts through the Deployment
Console tool. Describes JSON request syntax
and REST calls. Discusses relational database
concepts and implementation of the Enterprise
Data Connector. Goes deep into the server to
discuss state, persistence, and invocations by
version or effective date. Includes troubleshooting
servers though logs, server monitoring
techniques, performance diagnostics, and
recommendations for performance tuning.

Corticon Server: Integration and Deployment
Guide

Details setting up an installed Corticon Server as
a Web Services Server, and then deploying and
exposing Decision Services as Web Services on
the Pacific Application Server (PAS) and other
Java-based servers. Includes samples of XML
and JSON requests.

Corticon Server: Deploying Web Services with
Java

Details setting up an installed Corticon Server as
a Web Services Server, and then deploying and
exposing decisions as Web Services with .NET.
Includes samples of XML and JSON requests.

Corticon Server: Deploying Web Services with
.NET
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Presents the features and functions of remote
connection to a Web Console installation to
enable manage Java and .NET servers in groups,
manage Decision Services as applications, and
monitor performance metrics of managed servers.

Corticon Server: Web Console Guide

Provides reference information about TCMAN,
the command-line utility for managing and
administering the Pacific Application Server.

Pacific™ Application Server for Corticon®:
TCMAN Reference Guide

Overview of Progress Corticon
Progress® Corticon® is the Business Rules Management System with the patented "no-coding"
rules engine that automates sophisticated decision processes.

Progress Corticon products
Progress Corticon distinguishes its development toolsets from its server deployment environments.

• Corticon Studio is the Windows-based development environment for creating and testing
business rules:

• When installed as a standalone application, Corticon Studio provides the complete Eclipse
development environment for Corticon as the Corticon Designer perspective.You can use
this fresh Eclipse installation as the basis for adding other Eclipse toolsets.

• When installed into an existing Eclipse such as the Progress Developer Studio (PDS), our
industry-standard Eclipse and Java development environment, the PDS enables development
of Corticon applications in the Corticon Designer perspective that integrate with other
products, such as Progress OpenEdge.

Note:  Corticon Studio installers are available for 64-bit and 32-bit platforms. Typically, you use
the 64-bit installer on a 64-bit machine, where that installer is not valid on a 32-bit machine.
The 64-bit Studio is recommended because it provides better performance when working on
large projects. When adding Corticon to an existing Eclipse, the target Eclipse must be an
installation of the same bit width. Refer to the Corticon Installation Guide to access, prepare,
and install Corticon Studio.

• Corticon Servers implement web services for deploying business rules defined in Corticon
Studios:

• Corticon Server for Java is supported on various application servers, and client web
browsers. After installation on a supported Windows platform, that server installation's
deployment artifacts can be redeployed on various UNIX and Linux web service platforms
as Corticon Decision Services.

• Corticon Server for .NET facilitates deployment of Corticon Decision Services on Windows
.NET Framework and Microsoft Internet Information Services (IIS).

Use with other Progress Software products
Corticon releases coordinate with other Progress Software releases:

Progress Corticon: Installation Guide: Version 5.510
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• Progress OpenEdge is available as a database connection.You can read from and write to an
OpenEdge database from Corticon Decision Services. When Progress Developer Studio for
OpenEdge and Progress Corticon Studio are integrated into a single Eclipse instance, you can
use the capabilities of integrated business rules in Progress OpenEdge. See the OpenEdge
document OpenEdge Business Rules for more information. OpenEdge is a separately licensed
Progress Software product.

• Progress DataDirect Cloud (DDC) enables simple, fast connections to cloud data regardless
of source. DataDirect Cloud is a separately licensed Progress Software product.

• Progress RollBase  enables Corticon rules to be called from Progress Rollbase. Rollbase is a
separately licensed Progress Software product.
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1
Overview of Corticon Installations

This guide presents the preparation and procedures for accessing, downloading, and running
Corticon 5.5 installers, as well as dynamic access to the supported platforms and links to the setup
of third-party software in the Progress Corticon KnowledgeBase.
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2
Preparing for a Corticon Installation

Before running installers
To avoid possible constraints on the installer, do the following:

• Confirm that you have Administrator permissions on the target machine - Administrator
rights allow the installer to copy all the Corticon files to their proper locations.You must have
Administrator rights and permissions to install this software. See your system administrator to
obtain these rights.

• Obtain system access -  Several Corticon features write files to the “home” directory structure. If
the target machine for the Corticon installation does not have read and write access to this
directory, you need to choose a directory location where Corticon will have both read and write
access.

• Disable anti-virus, anti-malware, and anti-spyware protection applications - Before
performing the installation, we recommend temporarily disabling any anti-virus and anti-spyware
software that may be running on the target machine, as such software might interfere with
correct installation.

For details, see the following topics:

• Evaluation licensing

• System requirements

• About Corticon upgrades

• Downloading Corticon installer packages

• Applying a Service Pack update
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Evaluation licensing
Progress Corticon products are licensed for evaluation immediately after installation.

Studio Licensing - Corticon embeds a ninety-day evaluation license that enables development
of business rules projects and the use of the Enterprise Data Connector (EDC), as well as testing
of the projects in an embedded test server.You must obtain Studio development licenses from
your Progress representative.

Server Licensing - Corticon embeds a limited evaluation license that enables testing of rule
modeling projects on supported platform configurations.You must obtain server deployment
licenses and server licenses that enable the Enterprise Data Connector (EDC) from your Progress
representative. See Limits of the Server evaluation license on page 42 to determine whether the
evaluation license will constrain your evaluation.

System requirements
Progress Corticon products are supported on a variety of platforms and third-party components.

Corticon Studio
Refer to the Progress Software web page Progress Corticon 5.5 - Supported Platforms Matrix to
review the currently supported Corticon Studio operating systems, and Eclipse versions.

The target system for a Corticon Studio installation requires:

• Supported Windows operating system

• 8 GB System RAM (minimum of 2 GB available RAM)

• 650 MB disk space

• When an existing Eclipse will be used, a supported Eclipse version

Corticon Server for Java
Refer to the Progress Software web page Progress Corticon 5.5 - Supported Platforms Matrix to
review the currently supported platforms and application servers. Also see the Corticon
KnowledgeBase entry  Corticon Server 5.X sample EAR/WAR installation for different Application
Servers  for detailed instructions on configuring Apache Tomcat, JBoss, WebSphere, WebLogic
on all supported platforms.

The target system for a Corticon Server for Java installation requires:

• Supported Windows operating system

• When deploying on other platforms, a supported operating system and application server

• 8 GB System RAM (minimum of 2 GB available RAM)

• 600 MB disk space

Progress Corticon: Installation Guide: Version 5.516
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Corticon Server for .NET
Refer to the Progress Software web page Progress Corticon 5.5 - Supported Platforms Matrix for
information on supported .NET Framework and IIS versions, and the Corticon Knowledgebase
articles Steps to set up IIS 7.5 on Windows Server 2008 or Windows 7 for Corticon .NET Server
5.x and Steps to set up IIS 8.0 and 8.5 on Windows Server 2012 R1 and R2 for Corticon .NET
Server 5.x for detailed setup instructions.

The target system for a Corticon Server for .NET installation requires:

• Supported .NET Framework and Internet Information Service (IIS)

• 8 GB System RAM (minimum of 2 GB available RAM)

• 500 MB disk space

Note:  Corticon's Enterprise Data Connector (EDC) can be configured for Corticon Studio and
either Corticon Server. Refer to the Progress Software web page Progress Corticon 5.5 - Supported
Platforms Matrix to review the currently supported databases when using EDC with Corticon Studio
or Server.

Corticon Web Console
Refer to the Progress Software web page Progress Corticon 5.5 - Supported Platforms Matrix for
information on supported browser versions.

The target system for a Corticon Web Console installation requires:

• 4 GB System RAM (minimum of 2 GB available RAM)

• Java option for MaxPermSize set to at least 256m

• 600 MB disk space

Note: When all three Server components are installed on one machine, the required space for
the installation is about 1 GB.

About Corticon upgrades

Upgrading from an earlier release
Existing Corticon users advancing to this release will want to know whether their existing products
can co-exist with the newer version, as well as any strategies for perpetuating the assets created
in their current version.

If you have an existing installation of Corticon products on the target machine, do the following:

• For an upgrade of a 5.3 or 5.4 installation to 5.5 - If you are upgrading from 5.3 or 5.4, you
can install 5.5 as a separate installed software on the same machine.You must manage any
port overloads that might result from running both versions.

• For an upgrade of a 5.2 or earlier version 5 installation to 5.5 - An installed version of
Corticon 5.2 or earlier installed on the target machine must be uninstalled, then the appropriate
Corticon 5.5 product installed.

You might want to consult with Progress Corticon Support or your Progress representative to
discuss your migration strategies for existing assets before you take action.
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• For an upgrade of a 4.3 or earlier installation to 5.5 - An installed version of Corticon 4.3 or
earlier installed on the target machine must take an intermediate step of upgrading its assets
to at least 5.3, and then uninstalled.To accomplish this, you must download and install Corticon
Studio 5.3.0 or 5.4.0, and then perform the procedures in its Corticon Migration Guide. Once
completed, uninstall the 4.3 installation, and install the 5.5 where its upgrade utility can bring
project assets up to date.You might want to consult with Progress Corticon Support or your
Progress representative to discuss your migration strategies for existing assets before you take
action.

Downloading Corticon installer packages
To download required Corticon installers:

1. Get credentials to access and download packages on the Progress Software Electronic Software
Download (ESD) site.

2. Connect to the ESD, and then navigate to the Corticon 5.5 pages.

3. Locate, download, and save the required installers to a temporary location accessible by the
target machine.

Downloading the Corticon Studio installer packages

Note:  Corticon Studio 5.5 installers are available in packages for 64-bit and 32-bit platforms. Refer
to your target machine's Control Panel > System page to choose the appropriate package. While
you could install the 32-bit version on a 64-bit machine, it is not recommended.

Corticon Studio 5.5.0 products (and, when available, the latest Service Packs) are packaged in
executable installer applications:

• For supported 64-bit Windows machines:PROGRESS_CORTICON_5.5_STUDIO_WIN_64.exe.

• For supported 32-bit Windows machines:PROGRESS_CORTICON_5.5_STUDIO_WIN_32.exe.

Downloading the Corticon Server and Web Console packages
Corticon Server and Web Console 5.5.0 products -- Java Server, .NET Server, and Web Console
-- (and, when available, the latest Service Packs) are packaged in executable installer applications:

• For supported 64-bit Windows machines:PROGRESS_CORTICON_5.5_SERVER_WIN_64.exe.

• For installing Corticon Server or Web Console on other supported platforms or application
servers:: PROGRESS_CORTICON_5.5_SERVER.zip.
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Applying a Service Pack update
When Progress releases a Service Pack for a version, the update is applied to an existing installation
that the Service Pack update wizard discovers on the target machine. To apply a Service Pack,
navigate to the Service Pack's download page to download the appropriate package, and then
unpack it on the target machine. For a new installation, perform the tasks for Installing Corticon
Studio on page 21, or Installing Corticon Servers and Web Console on page 33, and then run the
corresponding 5.5.x Service Pack update wizard. For an existing 5.5 installation, just run the
appropriate 5.5.x Service Pack to update the installation in place.

Note:  A higher Service Pack for a version rolls up the features of all preceding Service Packs.
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3
Installing Corticon Studio

There are several techniques for installing Corticon Studio:

• Running the Corticon Studio installer wizard on page 22, the typical use, which enables a
complete Corticon Studio Eclipse installation that can standalone, or be tailored into another
Eclipse IDE on the same machine, such as Progress Developer Studio for OpenEdge.

• Performing Silent Installations that generates a file from an installer wizard run to let you perform
silent Studio installations on other machines.

• Installing Corticon Studio plugins into an existing Eclipse on page 27 which enables scripted
installation of Corticon Studio plugins into an existing Eclipse.

What Corticon Studio installers provide
The installer wizard package includes:

• Corticon Studio resources

• Corticon Studio online documentation

• Eclipse Development Environment and Eclipse online documentation.

• Java Runtime Environment (JRE)

• Sample projects

• Tutorials

• API documentation for extending Corticon

• Corticon Server runtime for use in testing rules you create in Corticon Studio
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Installation options
A new Corticon Studio install lets you choose to install it standalone, or to add its resources to
either Progress Developer Studio for Open Edge 11.4/11.5 or another existing Eclipse 4.3
installation.

For details, see the following topics:

• Running the Corticon Studio installer wizard

• Performing Silent Installations of Studio

• Installing Corticon Studio plugins into an existing Eclipse

• Optional post-install Studio tasks

Running the Corticon Studio installer wizard
To perform a new installation of Corticon Studio 5.5.0:

1. Double click on the appropriate installer file, PROGRESS_CORTICON_5.5_STUDIO_WIN_64.exe
or PROGRESS_CORTICON_5.5_STUDIO_WIN_32.exe, to launch the Corticon Studio installer.

The installer opens in the installer wizard.

2. The first installer panel opens with information about the installer.

3. Click Next to continue.

The License Agreement panel opens.

Progress Corticon: Installation Guide: Version 5.522
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This screen displays the Progress Software End User License Agreement (EULA). Use the
scroll bar at the right of the screen to read the agreement content.

4. When you understand and agree to the terms, choose I accept the terms in the license
agreement, and then click Next to continue.

The Choose Install Folder panel opens.
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5. Note:  If you choose to install the 32-bit product on a 64-bit machine, the installation directory
defaults to C:\Program Files (x86)\Progress where (x86) distinguishes 32-bit
applications.The documentation will refer to C:\Program Files\Progress as the installation
path so be aware of this variation.

Specify the installation location. The default location for the installation directory and the work
directory are as shown above. (For the work directory, the default subdirectory under Users
is the current username.) Either accept the default locations, or specify each preferred (and
different) location.

When you have the locations specified, click Next to continue.

6. The installer attempts to discover an existing Progress Developer Studio for OpenEdge on the
machine. If the Eclipse/OpenEdge version are compatible, and if the installer is the corresponding
bit width, the following panel opens:

If this panel is displayed, choose whether to add the Corticon Studio plug-ins into that Progress
Developer Studio for OpenEdge location to get the benefit of a tailored installation, and then
click Next to continue.

7. If you had no Progress Developer Studio for OpenEdge installation, or passed on installing into
a discovered Progress Developer Studio for OpenEdge, the External eclipse configuration
panel opens:
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• If you select Yes on this panel, the entry area for the External Eclipse location in which
you want to add Corticon Studio (in addition to a standard installation) is presented:

Enter or browse to the location of the Eclipse target that is the same bit width as the installer
you are running.

• If you leave the selection as No, a normal installation will proceed.

When you have decided which path to take, click Next to continue.
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8. The Pre-installation Summary panel opens.

Confirm that your installation location has adequate disk space for the Corticon Studio
components as well as at least 100 MB of workspace.

9. Click Install to continue.

An installation status window opens to display the state of the installation process. When the
process has finished, the Install Complete panel opens.

10. Click Done to quit and close the installer.

The installation of Corticon Studio is complete.

Performing Silent Installations of Studio
An unattended (silent) install requires that you first run an installation or updater in the installer
wizard to capture the selected options, and then use the captured response file on other targets
to 'playback' the responses into the installer without any user interaction.

Note: The bit width of the installer package and the target machine's bit width must correspond.

To perform silent installations for Corticon Studio:

1. Run the Studio installer with your preferred locations and options to capture a response file,
using the syntax installer.exe -r file where installer is the preferred Studio installer,
and file is the response file you will reuse. For example,
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PROGRESS_CORTICON_5.5_STUDIO_WIN_64.exe -r
C:\CorticonStudio64_55.responses

2. On other target machines, access the Studio 5.5 installer executable and the response file.

3. Run the installer using the syntax installer.exe -i silent -f file where installer
is the Studio installer, and file is your response file. For example,
PROGRESS_CORTICON_5.5_STUDIO_WIN_64.exe -i silent -f
C:\CorticonStudio64_55.responses.

Installing Corticon Studio plugins into an existing
Eclipse

These instructions apply when you want to install Corticon functionality into an installed Eclipse
IDE.The technique uses a script to install plugins into an installed Eclipse 4.3.1 or 4.3.2 development
environment.

1. A Java Software Development Kit (JDK) is required for Corticon, not just a Java Runtime
Environment (JRE). If you do not have one installed locally, download and install a 1.6 or higher
(1.7 preferred) version of the same bit-width as the existing Eclipse from the Oracle Java website
http://www.oracle.com/technetwork/java

Note:  For the installation of the Corticon Studio plugins, you can use the JRE that Eclipse is
using. In Eclipse, choose Window > Preferences, then select Java > Installed JREs.

2. Download and perform a standard installation of Corticon Studio into a clean directory on the
target machine. This installation will provide the script and the required files for the integration
into your target Eclipse location.

3. In a Command Prompt window at the Corticon Studio's [CORTICON_HOME]/Studio location,
check to see whether JAVA_HOME is set. If not, set JAVA_HOME to the JDK root. For example:
set JAVA_HOME=c:\jdk1.7u67_64

4. Confirm that neither the installed Corticon Studio or the target Eclipse are running.

5. In the Command Prompt, run the integration script in the form:

integrateCorticon.bat –install eclipse_target

where eclipse_target is the root directory of the target Eclipse installation.

Eclipse installs its required plug-ins.

6. To ensure that Corticon Ruletests can locate javac to compile rules, add the path of the JDK
to your PATH as the default Java to use. For example:

set PATH=%JAVA_HOME%\bin;%PATH%

7. Specify the Corticon work directory, the folder where you want Corticon to write its log and other
temporary files. For example:

set CORTICON_WORK_DIR=c:\corticon_work_dir
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8. When the script successfully completes, restart the Eclipse session, and then verify the
installation by selecting the menu command Help > About Eclipse. Click Installation Details
to confirm that Progress Corticon Feature is installed.

9. Open a project, and then run a Ruletest. A successful run indicates that the Java compiler is
being accessed correctly.

The integrateCorticon script enables other functions:

COMMAND SYNTAX AND OTHER OPTIONS
================================
Usage: integrateCorticon [OPTION] [TARGET_ECLIPSE]
Manage installation of Corticon plugins in an Eclipse install
-install Install Corticon plugins in TARGET_ECLIPSE
-uninstall Uninstall Corticon plugins from TARGET_ECLIPSE
-update Update Corticon plugins in TARGET_ECLIPSE
-updateParams Update Corticon plugins parameters in TARGET_ECLIPSE
-help Display this message

Optional post-install Studio tasks
Once Studio is successfully installed, there are a few tasks you might want to perform.

Upgrading projects coming forward from a prior release
Every time you install a new release of Corticon Studio, many Corticon development assets
(Vocabularies, Rulesheets, Ruleflows, and Ruletests) might need to be upgraded for use in the
Corticon Studio. These could be projects you were working on or samples you imported from
another location. As you open each asset that needs to be upgraded, you are alerted as to the
required action, and encouraged to proceed to upgrade it. The asset upgrade process will force
the upgrade of dependent assets that also require a similar upgrade. This task can be tedious if
you have a lot of assets and a lot of projects.

The project upgrade utility lets you choose projects or folders of projects that will be upgraded all
in one pass. Typically, you would bring the projects into your workspace but you could choose to
point to folders that contain projects.

Performing this procedure just after upgrading your Corticon Studio will relieve you of having to
do this task as you work.

To upgrade a selected project:

1. After your Studio upgrade has succeeded, choose the Upgrade command,

, on the dropdown menu that opens when you right-click on any
project name in the Projects Explorer view.The Upgrade Assets dialog box opens, as shown:
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In this example, the LifeInsurance project was selected so all the assets in that project are
selected for upgrade.

2. Click Finish to start upgrade processing.You are alerted that this process cannot be undone,
so consider whether you should cancel, backup the files as-is, and then run the same upgrade
process again to completion.

3. After processing, the Update Results window opens, listing the assets that required upgrade
and were upgraded, as well as those that did not require an upgrade, as shown:

29Progress Corticon: Installation Guide: Version 5.5

Optional post-install Studio tasks



You can choose to click Copy, and then paste the text into your preferred text editor.

4. Click OK to close the results window and the dialog box.

To upgrade one or more projects in one run:

1. Choose the Upgrade command, , on the dropdown menu that opens
when you click Project on the Corticon menubar (or on the dropdown menu of a selected project
in the Project Explorer tabs) The Upgrade Corticon Assets dialog box opens.

2. Click Browse to navigate to the branch of tree that could contain several Rule Projects, and
click OK. The projects and their assets are listed in the Upgrade Assets dialog box, as in this
example:
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Note:  For best performance, choose just several projects to upgrade in one run, and then
perform as many runs as needed.

3. Click Finish to start upgrade processing.You are alerted that this process cannot be undone,
so consider whether you should cancel, backup the files as-is, and then run the same upgrade
process again to completion.

4. After processing, the Update Results window opens, listing the assets that required upgrade
and were upgraded, as well as those that did not require an upgrade.You can choose to click
Copy and then paste the text into your preferred text editor.

5. Click OK to close the results window and the dialog box.

Changing the Studio's memory allocation
When working on large projects, you will get better performance by increasing the available memory
for Corticon Studio. To change the Corticon Studio memory allocation, edit the command file
eclipse.ini located at [CORTICON_HOME]\Studio\eclipse, and then change (typically,
increase) the Xmx value (maximum memory setting). The default Xmx setting is 384 megabytes,
specified as Xmx384m.
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4
Installing Corticon Servers and Web Console

This section provides information about the installation procedures for the deployment and
administration components of Corticon as well as the Progress Pacific Application Server (PAS)
-- a Web application server based on Apache Tomcat -- that is used by the Java Server and the
Web Console.

There are several techniques for installing Corticon Server components:

• Running the Server and Web Console installer wizard on page 34, the typical use, which enables
a complete Corticon Server for Java (and PAS), Corticon Server for .NET, and Corticon Web
Console (and PAS).

• Performing Silent Installations that generates a file from an installer wizard run to let you perform
silent installations of Server components on other machines.

• Using packages that facilitate setup of Corticon Server for Java and Java Server Console on
supported UNIX/Linux platforms and brands of Application Servers. Refer to the Progress
Software web page Progress Corticon 5.5 - Supported Platforms Matrix for the currently
supported platforms and app servers. Then see the Corticon KnowledgeBase entry  Corticon
Server 5.X sample EAR/WAR installation for different Application Servers  for detailed instructions
on configuring Apache Tomcat, JBoss, WebSphere, WebLogic on all supported platforms.

Note: The previous console implementation, Server Console, that was enabled in a Java Server
installation is still available. This legacy tool will be phased out in upcoming releases as the new
Web Console replaces the legacy tool's functionality.

For details, see the following topics:

• Running the Server and Web Console installer wizard

• Performing Silent Installations of Server Components

33Progress Corticon: Installation Guide: Version 5.5

https://community.progress.com/community_groups/corticon/w/brms/2447.progress-corticon-5-5-supported-platforms-matrix.aspx
http://knowledgebase.progress.com/articles/Article/000034367
http://knowledgebase.progress.com/articles/Article/000034367


• Additional tasks after upgrading .NET Server

Running the Server and Web Console installer wizard
You can install Corticon Servers and the Web Console on a machine that does not already have
them installed. If you are upgrading from 5.3 or 5.4, you can install 5.5 as a separate installed
software version on the same machine.You must manage any port overloads that might result
from running both versions.

Note:  An installed version of Corticon Server 5.2 or earlier on the target machine must be
uninstalled, then Corticon Server 5.5 installed. Consult with Progress Corticon Support or your
Progress representative to consider your migration strategies for existing assets before you take
action.

Installation procedure
If you have already installed either of the 5.5 Servers or the Web Console, the installer will allow
you to install components not previously installed.

To create an installation of Corticon Servers (Java and .NET) and Web Console 5.5:

1. On the target machine, access the Corticon 5.5 installers you downloaded.

2. Double click on PROGRESS_CORTICON_5.5_SERVER_WIN_64.exe   to open the Progress
Corticon Server Setup Wizard.

The installer opens in the installer wizard.

3. The first installer panel opens with information about the installer.

4. Click Next to continue.
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The License Agreement panel opens.

5. After you have read, understood, and agreed to the terms of the End User License Agreement,
choose I accept the terms of the license agreement, and then click Next.

The Choose Install Folder panel opens.

6. The default installation directories are shown.

To specify preferred directories on each line, either enter the explicit path, or click Choose to
browse to each preferred directory.
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Click Next.

The Choose Server Components panel opens.

7. Choose the one or more components you want to install at this time. Any components already
installed are chosen and greyed out.

Click Next.

If you selected the Java Server or Web Console, the Corticon Port Numbers panel opens.
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8. If any of the preferred ports conflict with existing applications, you can change them at this time
to an integer value from 1024 to 49151. Be aware that the documentation references these
ports as though the default values, as shown, were accepted. Consult with your system
administrator to identify alternate ports you might use, or to reset the ports on the conflicting
applications.

Enter your preferred port numbers, and then click Next.

The Pre-Installation Summary page opens.

9. Verify your selections in the Pre-Installation Summary panel. Nothing has happened yet so
you can click Previous to go back to a panel to make changes, or click Cancel to quit this
installation procedure.

10. Click Install to continue.

The installation status window opens.

When done, the Install Complete panel opens.

11. Choose Done to complete the Corticon Server / Web Console installation and close the installer.

Performing Silent Installations of Server Components
An unattended (silent) install requires that you first run an installation or updater in the installer
wizard to capture the selected components and options, and then use the captured response file
on other targets to 'playback' the responses into the installer without any user interaction.

To perform silent installations for Corticon Server Components:

1. Run the Server installer with your preferred locations and options to capture a response file,
using the syntax installer.exe -r file where installer is the preferred Server installer,
and file is the response file you will reuse. For example,

37Progress Corticon: Installation Guide: Version 5.5

Performing Silent Installations of Server Components



PROGRESS_CORTICON_5.5_SERVER_WIN_64.exe -r
C:\CorticonServer64_55.responses

2. On other target machines, access the Server 5.5 installer executable and the response file.

3. Run the installer using the syntax installer.exe -i silent -f file where installer
is the Server installer, and file is your response file. For example,
PROGRESS_CORTICON_5.5_SERVER_WIN_64.exe -i silent -f
C:\CorticonServer64_55.responses.

Additional tasks after upgrading .NET Server
While the Corticon Knowledgebase articles Steps to set up IIS 7.5 on Windows Server 2008 or
Windows 7 for Corticon .NET Server 5.x and Steps to set up IIS 8.0 and 8.5 on Windows Server
2012 R1 and R2 for Corticon .NET Server 5.x discuss initial setup of IIS for use with Corticon, only
a subset of those instructions must be applied when you have installed the 5.5 .NET Server on a
machine that was running Corticon 5.4 .NET Server in IIS. Typically, only one version of Corticon
.NET Server is active.

To update IIS for Corticon 5.5 and then install Corticon into the IIS location:

1. On the target machine where IIS has been supporting Corticon .NET Server 5.4, successfully
install Corticon .NET Server 5.5.

2. In Control Panel > Programs and Features, select Turn Windows feature on or off, and
then expand to Internet Information Services > World Wide Web Services. Select all the
features in the group Common HTTP Features.

3. Start Administrative Tool > IIS Manager. In the Actions panel, click Stop.

4. In [CORTICON_HOME_5.5]\Server .NET\IIS, launch install.bat.

5. Accept or adjust the target location, and then enter a at each prompt to accept all updates.The
5.5 resources and the deployment descriptor files are copied. The corresponding assets are
copied to the IIS path, /Samples/Rules Projects.

6. In the IIS Manager, on the Actions panel, click Start.
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5
Registering your Corticon license

Progress Corticon customers must replace the evaluation license to enable the licensed features
and time limits.

When you obtain a license file, it applies to Studios as well as Servers.You must perform
configuration tasks to record it for each Corticon Studio, each Corticon Server, and each Deployment
Console. If you intend to use EDC on your Corticon Servers, your Corticon license must allow it.
Contact Progress Corticon technical support if you need to acquire a license.

For details, see the following topics:

• Updating your Corticon Studio license

• Updating your Corticon Server license

Updating your Corticon Studio license
When you are provided a license for Corticon Studio, you receive a JAR file. Save the file on the
target machine or at a location that is network-accessible to the installation. The default license
file for evaluation is embedded within the installation and cannot be replaced directly. In this
example, the license file, CcLicense.jar, that both Studio and Server will use is placed at
C:\licenses.

To update the evaluation Studio license, or add your non-evaluation Studio license:

1. With Studio running, select the menu command Window > Preferences.

2. Expand the Progress Corticon group.

3. In the License File entry area, enter or browse to the location of the license JAR:
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4. Click Apply, and then click OK.

5. Restart Corticon Studio.

Limits of your Corticon Studio license within Progress
Developer Studio for OpenEdge

To facilitate creation of a combined OpenEdge and Corticon Eclipse development environment,
Corticon Studio includes a WAR file to enable running Corticon Server from the Progress Developer
Studio. The embedded Studio license for Corticon Server has the following constraints:

• Corticon Server requests must originate on the machine where the server is running -- in other
words, all on localhost. Requests from any other machine or host are not allowed.

• Corticon Server allows only one reactor for execution of one instance of a specified Decision
Service. As a developer, you can locally deploy many Decision Services simultaneously, and
you can use administrative functions, such as service availabilities. When you are ready for
production system testing, you must obtain a Corticon Server deployment license, and then
locate it in Corticon Server installations.

Updating your Corticon Server license
When you obtain a Server license file as a customer, you need to locate it at the default locations
as well as the runtime locations.
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Updating the .NET server license
Copy your CcLicense.jar file, and then paste it to replace the existing file at:

• [CORTICON_HOME]\Server .NET\samples\lib\

• [CORTICON_HOME]\Server .NET\webservice\lib\

• The IIS location, typically: C:\inetpub\wwwroot\axis\lib\

Updating the Java server license
Copy your CcLicense.jar file, and then paste it to replace the existing file at:

• [CORTICON_HOME]\Server\lib\

Note: When you download .ear and .war files for deployment onto other supported platforms
and application servers, they contain the evaluation CcLicense.jar. Once you are a Corticon
customer, you are provided a permanent version of this file. Inserting the CcLicense.jar file
into the .ear or .war will replace the evaluation file to redefine the license limitations.

Note:  If you intend to use the Corticon High Performance Batch Processor, you will need to also
update its license file, located at [CORTICON_HOME]\Samples\HPBP\src\test\resources\
.

Once you have run Corticon Server, you can update its license locations with your license.

To configure Corticon Server to access your license file:

1. Stop Corticon Server.

2. Copy your license JAR by its default name, CcLicense.jar.

3. Navigate to the installation's [CORTICON_HOME]\Server\lib directory to paste the file and
overwrite the existing file in that location.

4. Navigate to the installation's
[CORTICON_WORK_DIR]\Server\pas\server\webapps\axis\WEB-INF\lib directory
to paste the file and overwrite the existing file in that location.

When you restart Corticon Server, your license file will be referenced.

When you launch the Corticon Deployment Console, your license with its registration information
is registered for the Corticon Deployment Console. If your license enables EDC, the Database
Access  fields and functions are enabled.
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Note:

You can choose to locate the license by another JAR name at a preferred location, and then
expressly identify it to the server.

To custom configure Corticon Java Server's license location:

1. Navigate in the file system to the installation's [CORTICON_HOME]\Server\bin subdirectory.

2. Double-click on testServerAxis.bat, then do the following:

a. Type 416 and then press Enter.

b. Enter (or copy/paste) the complete path to the location of the license JAR file, as in this
example, C:\licenses\myCorticon540EDC_CcLicense.jar. The command echoes
back Transaction completed.

c. To confirm the setting, type 415 and then press Enter. The path is echoed back (you might
need to scroll up to the command line.)

3. For the in-process instance, double-click on testServer.bat to perform the same 416 and
415 tasks as in Step 2 above

Limits of the Server evaluation license
The license included in the default Corticon Server installation has pre-set limits on certain Corticon
Server and Decision Service parameters. These limits are:

• Number of Decision Services – Up to 20 Decision Services may be deployed at any given
time. This means the sum total of all Decision Services loaded via .cdd files, Web Console,
or APIs cannot exceed 20.

• Number of Rules – All rules in all deployed Ruleflows (that is, all deployed Decision Services)
must not exceed 500. A rule generally consists of a single Condition/Action Column or a single
Action row in Column 0. Filter expressions do not count because they only modify other rules.

• Enterprise Data Connector (EDC) - EDC is disabled in a Server evaluation license and must
be explicitly licensed in a deployment Server license. Note that the Corticon Studio enables
EDC in both evaluation and deployment versions.

The Corticon Server log can capture errors and exceptions caused by expired or "under-strength"
licenses. These log messages are detailed in the Using Corticon Server logs section of the
Integration and Deployment Guide.

If you are Progress Corticon customer, you should have access to an unlimited license that will lift
these restrictions. If you are an evaluator, and discover that these limitations are preventing or
inhibiting your evaluation, contact your Progress Software representative to get a license with
expanded capabilities.
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6
Uninstalling Corticon Products

Uninstalling Corticon Studio
To remove a version of Corticon Studio, use this procedure.

Note:  Uninstall removes a complete major.minor version.You cannot uninstall just a Service Pack.

Note:  Uninstalling Corticon Studio 5.5 will not impact any other installed major.minor version of
Corticon Studio.

To uninstall Corticon Studio:

1. Close Studio.

2. Choose the Start menu Control Panel function Programs and Features, and then double-click
on Progress Corticon Studio 5.5 to launch its uninstaller.

Note: You could initiate the same task directly by navigating to
[CORTICON_HOME]\Uninstall_Progress Corticon Studio 5.5, and then running
Uninstall Progress Corticon Studio 5.5.exe.

The installed files in the Studio's [CORTICON_HOME] are removed. Files you created (including
the complete workspace) are NOT removed or replaced during this process.

If the Uninstaller program is unable to fully remove components (usually because they are open),
it will display messages, and might require a reboot to complete the process.
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Uninstalling Corticon Server
To remove a version of the server components to prepare for a new installation (or if you want to
fully remove them), use this procedure.

Note:  Uninstall removes a complete major.minor version.You cannot uninstall just a Service Pack.

Note:  Starting in 5.5, the Corticon Server components -- Corticon Server for Java, Corticon Server
for .NET, and the Corticon Web Console -- use common installation directories. As such, you
cannot choose to uninstall just selected components. Uninstallation will remove all installed server
components.

To uninstall Corticon Server:

1. Stop Corticon Servers.

2. Backup any files you want to retain.

3. Choose the Start menu Control Panel function Programs and Features, and then double-click
on Progress Corticon Server 5.5 to launch its uninstaller.

Note: You could initiate the same task directly by navigating to
[CORTICON_HOME]\Uninstall_Progress Corticon Studio 5.5, and then running
Uninstall Progress Corticon Studio 5.5.exe.

4. Navigate to [CORTICON_HOME]\Uninstall_Progress Corticon Server 5.5.

5. Run Uninstall Progress Corticon Server 5.5.exe.

The installed files in the Server's [CORTICON_HOME] are removed. Note that files you created
are NOT removed or replaced during this process. No server files in the [CORTICON_WORK_DIR]
are removed.

If the Uninstaller program is unable to fully remove components (usually because they are open),
it will display messages, and might require a reboot to complete the process.

Progress Corticon: Installation Guide: Version 5.544

Chapter 6: Uninstalling Corticon Products


	Notices
	Table of Contents
	Preface
	Progress Corticon documentation - Where and What
	Overview of Progress Corticon

	Overview of Corticon Installations
	Preparing for a Corticon Installation
	Evaluation licensing
	System requirements
	About Corticon upgrades
	Downloading Corticon installer packages
	Applying a Service Pack update

	Installing Corticon Studio
	Running the Corticon Studio installer wizard
	Performing Silent Installations of Studio
	Installing Corticon Studio plugins into an existing Eclipse
	Optional post-install Studio tasks
	Upgrading projects coming forward from a prior release
	Changing the Studio's memory allocation


	Installing Corticon Servers and Web Console
	Running the Server and Web Console installer wizard
	Performing Silent Installations of Server Components
	Additional tasks after upgrading .NET Server

	Registering your Corticon license
	Updating your Corticon Studio license
	Limits of your Corticon Studio license within Progress Developer Studio for OpenEdge

	Updating your Corticon Server license
	Limits of the Server evaluation license


	Uninstalling Corticon Products

